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Prepare and Configure the Event GDB  
 
This document will show the process for utilizing the GeoOps Incident Directory Structure and 
Event Geodatabase on an incident.  
 
See the GISS Workflow for more information and GeoOps for standards and definitions. 
 

Implement the Incident Directory 
Note: It is very important to begin with a new zip of the Current_GeoOps_Folder_Structure when setting 
up a project. This will allow the Pro Project Template to establish the correct file pathways. Reusing the 
folder structure or the Pro Project Template is not recommended. 
 

1. Download the Current GeoOps Folder Structure. 
2. Extract the zipped folder as close to the root of your working drive as possible. 
3. Rename the 2024_Template folder to the incident name. If the incident name contains 

more than one word, use CamelCase (i.e., 2024_CedarCreek). 
 

 
 

4. Enter Incident Information in the GeoOps File Namer spreadsheet in the \tools folder. 
The File Namer should be used throughout this process and the entire incident for 
maximum efficiency and consistency in file naming. Use the Zone field only if you are on 
a zoned incident. 

 

 

https://www.nwcg.gov/publications/pms936-1
https://www.nwcg.gov/publications/pms936
https://nifc.maps.arcgis.com/sharing/rest/content/items/e8459196b0324fa187ba3f407e08141e/data
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Configure the Pro Project Template 
 

1. In the \projects folder, open the 2024_ProProjectTemplate APRX file. 
2. A display issue affects the Home Folder name in some versions of Pro. Even after 

renaming it to the incident name, it may still display as 2024_Template in the project 
folders. Rename the Home Folder after confirming the underlying connection is correct.  
 

 
 

3. In the Project Databases folder under Contents, rename the Default GDB 
(other_incident_data GDB) with the incident name and Unique Fire ID. 

 

 
 
Note: A slow double-click on the database name in the Catalog View must be used to update the name. 
The Rename button will be grayed out. Be sure to rename the Default GDB prior to opening the provided 
Map View or a database lock will be created, and you will be unable to rename the Default GDB. 
 

4. Rename the Annotation and Progression GDBs. 
 

 
 

5. Navigate to the Project Maps folder. Open the provided map view 
{MapType}_2024_{IncidentName}.  
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a. Add the Incident Name to the map title but leave {MapType}. 
b. Repair the path of the DynamicTextUpdate table to the existing table in the 

Default GDB. 
 

 
 

c. Set the coordinate system of the map to a local projected coordinate system. 
 

 
Note: By setting the coordinate system now, all incident projects will inherit this configuration. 
If you do not wish to use the same coordinate system for all incident projects, this can be set after each 
Save-As of the ProProjectTemplate APRX. 
 

6. Save the Project.  
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Create the Edit Project 
1. Save As on the Pro Project Template to create a new project at the root of the projects 

folder, naming it edit_2024_{incidentName}_{localIncidentID}_{yourName}. 
This is the Edit Project, all data editing should be done here. 

  
 
Note:  Do not save the Edit Project in a OneDrive synced folder. If using OneDrive to sync the GeoOps 
directory from the incident’s SharePoint, save the Edit Project to a logical place on your local C: drive 
such as C:\2024_Incidents\Demo_2024. 

 
2. Add “edit” as the {MapType} to the Map View title.   

 
 
 

3. Open the DynamicTextUpdate table and fill in the Incident Name and Unique Fire ID 
attributes. If the incident name is more than one word, do not use CamelCase in attribute 
tables; use a space (e.g. “Cedar Creek”). 

 

 
Note: Values in the DynamicTextUpdate table will populate dynamic text elements in every template 
layout in every ArcGIS Pro project for the incident. It should be edited from the Edit Project while all other 
projects are closed so the updated values will populate properly. This provides a single source to update 
the current acreage and other attributes for all layouts at once. Additional attributes can be added and 
utilized with their own Dynamic Text tags. Multiple rows can be utilized with the use of a custom query. 
 

4. Save the edits to the table. 

https://pro.arcgis.com/en/pro-app/latest/help/layouts/add-dynamic-text.htm
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Create an Offline Copy 

Configure ArcGIS Pro Portals and Options 
 

1. Sign into NIFC AGOL as your active portal to access the GISS Edit Service. 
a. If your ArcGIS Pro license comes from a different account, follow the instructions 

provided in this article to configure your Portals. 
2. Set the download location. From the Project tab on the ribbon > Options > Share and 

Download > Offline Maps, select Ask where to save before downloading and click OK. 
 

 

Add GISS Edit Service 
1. In the Catalog pane, click on Portal and then the 

cloud with a star for My Favorites. Right-click the 
GISS Edit service and select Add To Current 
Map. 

 
  

https://www.esri.com/arcgis-blog/products/administration/administration/a-tale-of-two-portals-part-2-of-3/
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Note: To add the GISS Edit Service to the My Favorites menu, open the item page in AGOL from the 
bottom of the home page and click Add to Favorites under the thumbnail. 
 

 
  

2. The service can also be added by URL with 
Add Data from Path 
 

a. On the Map ribbon tab, open the Add 
Data dropdown and select “Add Data” 
from Path 

 
 

b. Copy and paste the URL path to the 
NIFC AGOL “GISS Edit Service 
(National Incident Feature Service” into 
the dialogue box. Both the NIFC Org 
URL and REST URL will work. 

 

Add a Vector Tile Layer base map 
 

1. Optionally, add a vector tile layer to your edit map as a basemap from the Data Layers – 
National Incident Base Data group in NIFC ArcGIS 
Online. An Esri basemap can be used as an alternative 
if a vector tile layer does not exist for your Geographic 
Area. Like the GISS Edit service, if you add the vector 
tile layer (not the vtpk) for your Geographic Area to 
your Favorites in NIFC ArcGIS Online, you can add the 
vector tile layer to your map in Pro from the Contents 
Pane > Portal > My Favorites. 
 
Prior to downloading the Offline Copy, your edit map 
contents should resemble the following: 

https://nifc.maps.arcgis.com/home/index.html
https://nifc.maps.arcgis.com/home/item.html?id=5de4bf5c50cb4cee8305485f4ad78996
https://nifc.maps.arcgis.com/home/item.html?id=5de4bf5c50cb4cee8305485f4ad78996
https://services3.arcgis.com/T4QMspbfLg3qTGWY/arcgis/rest/services/GISSEdit_NIFS_2024/FeatureServer
https://nifc.maps.arcgis.com/home/group.html?id=d585178d8b994f0c897c2b757d625883&view=table&focus=layers&categories=%5B%22%2FCategories%2FVector+Basemaps%22%5D&sortOrder=desc&sortField=modified#content
https://nifc.maps.arcgis.com/home/group.html?id=d585178d8b994f0c897c2b757d625883&view=table&focus=layers&categories=%5B%22%2FCategories%2FVector+Basemaps%22%5D&sortOrder=desc&sortField=modified#content
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Create an Offline Copy 
 
The Offline Copy is a mobile geodatabase (.geodatabase file extension) and should be 
used for all editing. While feature services can be edited directly in Pro, the NIFS should 
not be edited ‘live’ in Pro. 

 
Note: The coordinate reference system of the Offline Copy will be automatically reprojected to the 
local projected coordinate system of the map frame upon creation. 

 
1. Locate your incident using approximate coordinates from your Resource Order or search 

the Event Polygon feature layer for your incident name. There should be a triangle in 
Event Polygon that was auto-generated from IRWIN when the incident was created; the 
triangle can be used as a starting point and contains the correct IRWIN ID. 
 

2. After locating the triangle in the Event Polygon for the incident, zoom out to a 
geographic extent that captures the incident area and projected spread. Consider major 
transportation routes to and from the fire. If there are other fires in the area, attempt to 
exclude data from other incidents in your Map Frame. Data appearing within your Map 
Frame when you Download Map will be downloaded to your Offline Copy. 
 

 
 

3. From the Map tab on the ribbon > Offline section > click Download Map. 
 

a. If you added a vector tile layer as a basemap, check the box to Include basemap 
& tile layers and keep the max scale at the default value. 
 

b. Click Download and set the download location to the \incident_data\edit* folder 
and click OK. Do not move or rename the Offline Copy. 
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*Do not save the Offline Copy in a OneDrive synced folder. If using the incident’s SharePoint to 
store incident files, save the Offline Copy to a logical place on your local drive such as 
C:\2024_Incidents\2024_Demo. 

 
4. Once the download is complete, change the Contents pane to List by Data Source and 

confirm that the source for GISS Edit Service (National Incident Feature Service 2024) is 
now a mobile geodatabase (.geodatabase). 
 

 
 
5. If you downloaded a vector tile layer with the 

GISS Edit service, remove both the vector tile 
layer and vector tile package from the Contents 
pane:  

 
a. Locate the downloaded vector tile package 

(e.g. Basemap_WestGACCs…) in 
the \incident_data\edit folder in the Catalog pane, move it to 
the \base_data\basemaps folder and rename it 
{current date}_{time}_{incident name}_{Unit ID+ Local Incident ID}_24k_vector_base.vtpk 

 
b. Re-add the vector tile package from 

\base_data\basemaps to the map below but 
separate from the Event Group – All Layers in 
the Contents pane. 
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Repair Event Layer Files 
Use the Event layers in the edit map instead of the GISS Edit service directly. While the 
symbols are now the same, several other settings are saved in the layer files that are not 
available directly from the service, including caching, advanced labelling, and symbol display 
order. Critically, each layer is set to not cache any data locally in ArcGIS Pro to ensure the data 
displayed is always up to date. 
 

1. Repair the path of the Event Group - All Layers  in the Contents pane of the edit map to 
the newly created Offline Copy in the \incident_data\edit folder (e.g. 
GISSEdit_NIFS_2024_9A5A34…). 
 

2. Remove the GISS Edit Service (National Incident Feature Service 2024) group to avoid 
confusion. Save the Edit Project. 
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Configure Feature Templates 
 

1. Open the Manage Templates pane. This can be done from the Create Features pane or 
the dialog box launcher under the Features group on the Edit tab. 
 

  
 

2. Starting with Label Point, select all the features in the list and click Properties.  
 

 
 

3. Set the values for IncidentName and IRWINID and any other defaults you wish to apply. 
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4. Repeat the previous step for all the other layers, setting the defaults for any attributes 

you find useful. Note: See the GISS Workflow for more information on Obtaining IRWIN IDs for 
Incidents and Complexes. 
 
 

5. Once the Feature Templates for each of the Event feature classes are configured, save 
a layer file as a backup. A layer file will store both the symbology and more importantly, 
all the incident specific feature template settings just configured. 
 

a. Right-click the Event Group - All Layers in the Contents pane and select Save as 
a Layer File under Sharing. Save the file to the incident_data\edit folder following 
the GeoOps naming convention {year}_{incident name}_{unit ID+local incident 
ID}_{your name}_.lyrx 
 

 
 

Use this layer file to build a new Edit Project should you need to for any reason. 

Note:  In order to utilize all the settings saved in the layer file, add it to the map through the Add 
Data button. If the data has moved or you wish to apply it to a different feature class, you can 
repair/change the data source. 
 

  

https://www.nwcg.gov/publications/pms936-1/data-preparation/incident-information
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Edit Incident Data 
1. Add any ancillary data needed to perform accurate edits of incident data to the edit map. 
2. Secure incident information from the Situation Unit Leader. 
3. Process or convert any incident data external to the NIFS.  
4. Sync the Offline Copy. The Offline Copy in Pro can sync with the service more than 

once. There is no need to remove and re-download for each edit session. 
 

 
 
Note: SYNC-EDIT-SYNC: It is critical to Sync before each editing session as well as after. Syncing 
before will pull down any edits that have been made since the last sync. Not doing so will greatly increase 
the chances of a conflict and data being overwritten. 
 

5. Review new data in the NIFS. 
6. Edit data as you would any local dataset. 
7. Run Analysis. 
8. Update Metadata in the DynamicTextUpdate table. 
9. Export the Fire Perimeter to the Progression Geodatabase. 
10. Sync the Offline Copy. 

 
If needed, recreate the Offline Copy to account for an expanded area of interest. 
As a fire grows, it may be necessary to recreate the Offline Copy for a larger area. 
 

1. Remove the existing Offline Copy. 
 

 
 

Note: As of Pro 2.8, clicking Remove no longer automatically deletes the Offline Copy. Managing the 
older mobile geodatabases is required, similar to as it was with ArcMap, to avoid confusion. They can be 
renamed and archived or simply deleted. This is a bug and will be fixed in a future version. 
 

2. Zoom to the new area of interest and use the Download Map function to create a new 
Offline Copy. 
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Create the Master Incident GDB 
The Master Incident GDB is the database with which all incident maps should be created. The 
Master Incident GDB is stored in the incident_data folder and contains “Event” in the standard 
file name as it is the implementation of the Event Schema. No editing should be done in this 
geodatabase. 

The Offline Copy will need to be converted to a File GDB before being copied to the 
incident_data and incident_data\backups folders and renamed. Use the Mobile Geodatabase To 
File Geodatabase (Conversion) geoprocessing tool. 

Note: Some versions of Pro display a bug that prevents a File GDB from being copied or 
renamed if the name begins with a number. If encountered, use File Explorer to copy GDBs or 
rename to begin with “i_” as done for feature classes. 

 
Be sure your Master Incident GDB and all backups comply with GeoOps naming standards. 
 

Create Incident Maps 
The Pro Project Template APRX is the starting point to create master map projects.  

Layouts are included for the most common page sizes and all the text is tied dynamically to the 
provided map view and the DynamicTextUpdate table in the _other_incident_data.gdb. 
Instructions for updating the dynamic text are found in each layout. 

1. Open the 2024_ProProjectTemplate APRX file. 
2. Use Save As to save the template as a new project in the projects folder, naming it 

{mapType}_{year}_{incidentName}_{localIncidentID}.aprx. 
3. Open the existing map view {MapType}_2024_{IncidentName} and rename it with the 

map type and the incident name. This one project and Map View can be used to create 
all the map products for this type, regardless of printed size or multiple areas. 

4. Repair the data source for the existing layers (or add a new lyrx and repair) to the 
Master Incident GDB. 

5. Open or create a Layout in the appropriate size and customize it to the product type. 
6. Export and review your maps. 

 

https://pro.arcgis.com/en/pro-app/latest/tool-reference/conversion/mobile-geodatabase-to-file-geodatabase.htm
https://pro.arcgis.com/en/pro-app/latest/tool-reference/conversion/mobile-geodatabase-to-file-geodatabase.htm
https://www.nwcg.gov/publications/pms936/file-naming

	Implement the Incident Directory
	Configure the Pro Project Template
	Create the Edit Project
	Create an Offline Copy
	Configure ArcGIS Pro Portals and Options
	Add GISS Edit Service
	Add a Vector Tile Layer base map
	Create an Offline Copy

	Repair Event Layer Files
	Configure Feature Templates
	Edit Incident Data
	Create the Master Incident GDB
	Create Incident Maps

